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About this Guide

This guide provides a basic overview of installing and using EndNote. It assumes that you know how to
use your word processor and the Windows operating system. For help on these topics, consult your
computer guide or your word processor manual.

For additional information about using EndNote, consult the full EndNote.PDF manual found in your
EndNote folder or the online help. From EndNote’s Help menu, select Contents to view help topics. While
using EndNote, press F1 to view a help topic about the current window.







Introduction:

Welcome to EndNote

Introducing EndNote

Welcome to EndNote—the complete reference solution!

¢ EndNote is an online search tool—it provides a simple way
to search online bibliographic databases and retrieve the
references directly into EndNote. (EndNote can also import
data files saved from a variety of online services, CD-ROMs,
and library databases.)

¢ EndNote is a reference and image database—it specializes in
storing, managing, and searching for bibliographic
references in your private reference library. You can
organize images—including charts, tables, figures, and
equations—and assign each image its own caption and
keywords.

¢ EndNote is a bibliography and manuscript maker—it
formats citations, figures, and tables in Microsoft® Word
with the Cite While You Write'" feature. Watch the reference,
figure, and table lists grow as you insert citations in your
manuscript. Microsoft Word templates guide you through
the exacting manuscript requirements of publishers.

You can also create bibliographies using Format Paper with
other word processors.

See “What’s New in EndNote X” on page 9 for a list of the most
recent features added to EndNote.

For late-breaking news and updates, please go to:
http:/ /www .endnote.com/support.

About The Demo Version of EndNote and
the EndNote Viewer

If you are working with the demonstration version of EndNote
X, you have 30 days after you first use the program to evaluate
EndNote and all of its features. After those 30 days are up, the

Demo version will revert to a feature-restricted EndNote Viewer.

NOTE: While you can see the entire list of Microsoft Word templates
available with the full version of EndNote, the demo version includes
only the Nature manuscript template specifications. Any of the
manuscript templates you choose will launch the Nature manuscript
template.
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After the program reverts to an EndNote Viewer, you still will be
able to open EndNote libraries, search, sort, and print references.

With the EndNote Viewer you will not be able to:

¢ Add or edit references in a library that has 10 or more
references already in it.

¢ Format more than 10 citations in a paper.
¢ Retrieve more than 10 references from a remote database.
¢ Import more than 10 references.

Export more than 10 references at one time.

To purchase an unrestricted version of the EndNote program,
please contact Thomson ResearchSoft.

About This Getting Started Guide

This guide provides a basic overview of installing and using
EndNote. It is not a complete user’s guide, but rather is intended
as a guided tour to show you the highlights of the EndNote
program.

This guide assumes that you know how to use your Windows
operating system and your word processor. For help on these
topics, consult your computer owner’s guide or your word
processor manual.

Often there is more than one way to select a command in
EndNote. A single command may be available from one of the
main menus, from a context-sensitive right-click menu, from a
toolbar icon, or with a keyboard command. In most cases, this
manual gives instructions for selecting commands from the main
menus. If a menu command has a keyboard equivalent, the
keyboard command appears next to the menu item.

The following representations for key combinations are used:

Instruction Explanation
CTRL+EsC While holding down the CTRL key, press
the ESC key.

CTRL+ALT+ENTER While holding down the CTRL and ALT
keys, press the ENTER key.

Menu names, menu selections, and button names appear in italic
text.
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Customer Services

Register Your
Copy of
EndNote

The EndNote
Manual and
Online Help

Customer
Service

If you haven’t done so already, please fax or email

your registration to Thomson ResearchSoft (go to

http:/ /www.endnote.com/encontact.asp). You also have the
opportunity to register during installation. Even if you
purchased EndNote directly from Thomson ResearchSoft, do not
assume that you are registered. Registered users receive:

¢ free technical support
¢ special upgrade offers

¢ notification of new EndNote versions that are compatible
with the latest version of your word processor

The EndNote Manual: The complete EndNote manual is
available as a PDF file, and is installed in your EndNote folder.

Online Help: The online Help file is another source of
information about EndNote. From EndNote’s Help menu, select
Contents to view the various topics.

Release Notes: For documentation updates and correction notes
for this release, refer to the Readme.txt file installed in the
EndNote folder.

Late Breaking News: For late-breaking news and updates,
please go to: http:/ /www.endnote.com/support.

Contact Sales for general product information, pricing, quantity
discounts, and referrals to dealers.

Contact Customer Service to order new copies or upgrades of
EndNote, to check billing/shipping status, and to register your
software.

Sales Information

Phone: (760) 438-5526 (country code is 01)
Fax: (760) 438-5573 (country code is 01)
Web/Email: http://www.endnote.com/encontact.asp

Customer Service (Orders, Billing, and Shipping)
Phone: (800) 336-4474 (country code is 01)

Fax: (215) 386-2911 (country code is 01)

Web/Email: http://www.endnote.com/encontact.asp
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Technical
Support

International
Customer and
Technical
Support

The EndNote
Web Site

The EndNote-
Interest
Email Forum

Contact Technical Support if you encounter problems while
using EndNote. When you contact us, please have a clear
description of the problem and know the version of your copy of
the Windows system, EndNote, and your word processor. To
find the EndNote version, start EndNote and choose About
EndNote from the Help menu.

Our hours are Monday-Friday, 8:00 am — 5:00 pm Pacific Time.

Phone: (408) 987-5609 (country code is 01)
Web/Email: http://www.endnote.com/encontact.asp

Technical support tips are also available from the EndNote Web
site and the endnote-interest email forum (see the sections that
follow in this manual).

For customer support or technical support outside of North
America, please visit our Web site to check for a local distributor.

Go to http://www.endnote.com, click on Contact Us, and then
click on International Distributors to find a local distributor.

The EndNote Web site (http://www.endnote.com) contains
technical support tips, utilities for data transfer, and information
about the latest versions of EndNote. You can also find updated
styles, filters, connection files, and other related documents at
this site. Go to the Web site and look under Support and Services.

To easily locate incremental updates available on the Web site,
go to the Help menu in EndNote and select EndNote Program
Updates.

If you wish to join an ongoing email forum of EndNote users like
yourself, go to the EndNote Web site at

http:/ /www.endnote.com, click on Support and Services and then
scroll down for instructions on how to subscribe to the EndNote
Interest List.

There are two types of subscriptions: The first delivers the
endnote-interest messages individually, so that every time a user
sends a message to endnote-interest, it is redirected to each
member of the list. The second option is to subscribe to the
endnote-interest-digest—a daily compendium of endnote-
interest messages.
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ADA VPAT

In general, Thomson ResearchSoft does not answer questions
posted to endnote-interest, but lets users answer each other’s
questions. Contact Thomson ResearchSoft directly for a
guaranteed response from technical support staff.

Thomson ResearchSoft is dedicated to developing software
products that are usable for everyone, including those with
physical challenges and disabilities. EndNote was designed to
adhere to the ADA (Americans with Disabilities Act) Section 508
accessibility standards.

Please visit our Web site at http:/ /www.endnote.com, and click
the Support & Services link to access the VPAT (Voluntary
Product Accessibility Template) document that describes the
accessibility features that address the Section 508 Standards. The
VPAT is an informational tool developed by industry and
government to help facilitate the understanding of compatibility
issues under Section 508.

What’s New in EndNote X

EndNote X includes these new and enhanced features:

¢ Saveyour complete library (the filename.enl file as well as its
associated .DATA folder and all of its contents) to a single
compressed file in order to easily back up your library or
send a copy to a colleague.

¢ Let EndNote manage your PDF files and create links
automatically by simply dragging and dropping a PDF file
onto an EndNote reference. Link to PDF files in their original
locations (absolute paths), or link to copies saved with your
library (relative paths) for easy portability.

¢ View the contents of up to eight different fields in the
reference list display.

¢ Use Hide Empty Fields for references displayed in the
Reference window to reduce time spent scrolling through a
reference. Display all fields with Show Empty Fields.

¢ Easily find and select reference types from an alphabetized
list.

¢ Use additional reference types: Ancient Text, Dictionary,
Encyclopedia, and Grant. Electronic Source is renamed Web
Page.

¢ Use additional comparison operators for searching: "field
begins with," "field ends with," and "word begins with."
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¢ Use new and updated import filters, connection files and
output styles.
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Chapter 1:

Windows EndNote Installation

Before You Install EndNote

Program
Requirements

Please read this section before you proceed with the installation.

If you are installing the full version of EndNote (not the Demo
version), you will need a valid EndNote serial number to install
the program. If you are upgrading from a previous version, you
will also need your previous EndNote serial number.

Both the full EndNote program and the EndNote Demo are
available on CD or by downloading. If you have a CD you need
a CD-ROM drive to install the program.

System Requirements:

EndNote runs under the following operating systems:
¢ Windows 2000

¢ Windows XP

Hardware Requirements:

¢ A personal computer with a Pentium (or compatible) 450-
MHz or faster processor

¢ A minimum of 256 MB of available RAM
¢ A hard drive with at least 180 MB of free space

¢ In order to use EndNote’s Connect command to search
remote databases, an Internet connection is required. To use
the Open Link command to access a Web site, you also need a
Web browser installed.

NOTE: Make sure that your computer meets the system and hardware
requirements before continuing. If necessary, contact the distributor,
dealer, or store where you purchased EndNote to arrange for a full
refund. If you have any problem obtaining a refund, contact Thomson
ResearchSoft directly. You must do so within 30 days of purchase.

Word
Processor
Compatibility

As of June 2006, EndNote for Windows is compatible with:
¢ Microsoft Word for Windows 2000, XP (2002), 2003

¢ RTF files created with most word processors, including:
Microsoft Word, WordPerfect, OpenOffice, StarOffice, and
FrameMaker.
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EndNote for
Palm OS
Requirements

Microsoft Word:

Microsoft Word uses Cite While You Write, which inserts an
EndNote submenu of commands on Word’s Tools menu. It also
allows EndNote to format citations and create a bibliography for
the document that is open in Word. You can format, unformat,
and reformat a single document—without ever exiting your
word processor.

If a supported version of Microsoft Word is installed on your
computer, the appropriate Cite While You Write files are
installed automatically for the current user account when you
run the EndNote installation. This feature can be used with a
shared copy of Word or on a network.

In order for Cite While You Write to install properly:

¢ Microsoft Word 2000, XP, or 2003 must be correctly installed
on your computer prior to installing EndNote.

¢ The EndNote installer must be able to locate the Word
Startup folder. You need to have full read and write access to
Word’s Startup folder in order to install EndNote
commands.

RTF Documents:

For word processors other than Word, write your paper, insert
in-text citations, then save to an RTF file and use EndNote’s
Format Paper feature to format the citations and bibliography.
See Chapter 11 in the full manual for details.

If your computer has software installed to allow synchronizing

with a Palm OS® handheld device, the EndNote installation
program will ask whether you want to install EndNote for Palm
0s.

Requirements for running EndNote for the Palm Operating
System include:

¢ Handheld device

¢ Palm Operating System 4.1-5.x

¢ Serial or USB communication for HotSync operations
¢ 16 MB RAM

For information about how to use EndNote for Palm OS on your
handheld device, see the EndNote Help file. In EndNote, go to
the Help menu and choose Contents. See the Help topics in the
“Palm OS Handhelds” book.
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Installing EndNote

NOTE: Please see Chapter 20, “Using EndNote On a Network” in the
full EndNote.PDF manual for information about licensing, installing, and
using EndNote in a network environment.

To install EndNote:

1.

Log in to the local machine with administrative rights. Make
sure no applications are running, including virus protection
software.

Start the EndNote installation program.

If you downloaded the EndNote installer: Double click the
installer file to start the EndNote Setup program.

If you received EndNote on a CD: Insert the CD into your
CD-ROM drive.

The EndNote Setup program will start. If you do not have
Autoplay enabled, choose Run from the Start menu, type
“d:\setup” (use the drive letter appropriate to the drive
containing the installation CD) and press ENTER.

Follow the instructions on screen to complete the
installation. Use the Next button to move forward between
the installation dialogs.

Welcome: Thank you for selecting EndNote!

Read Me Information: Read late-breaking news about this
version of EndNote.

Palm Read Me Information: Read late-breaking news about
EndNote for the Palm operating system.

Registration Information (full version only; this will not
appear for the Demo version): Enter your name and
EndNote serial number. You must enter a valid serial
number to continue with installation of the full version of
EndNote. Your serial number appears on the EndNote
registration card or on the confirmation of your online order.
If you are upgrading from a previous version, you will also
need your previous EndNote serial number.

End User License Agreement: You must select “I accept the
license agreement” in order to continue with the installation.

Select Installation Type: We recommend that you select
Complete to make sure you install all options, or choose
Custom to hand pick the file groups to install.
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Select Destination: By default, EndNote is installed in the
C:\Program Files\EndNote X folder. The Demo version is
installed in the C:\Program Files\EndNote X Demo folder. You
can use the Browse button to change the folder selection if
you wish.

Custom
Installation
Options

NOTE: If a previous installation of EndNote is found in the same folder,
you will be given the option to either back up or overwrite the older files.
If you back up files, they are placed in a Backup folder in the installation
folder.

NOTE: If the installer detects a full version (not a demo version) of
EndNote on your computer, it will give you the option to continue with
the installation or quit. If you continue, be advised that you will need to
reinstall your non-demo version of EndNote to use it after you run the
EndNote X Demo version.

Select Components: (Custom installations only) If you
selected a Custom installation, see “Selecting Components”
on page 15.

Ready to Install: You can still click Cancel to stop the
installation. Once you click Next, the installation program
will begin installing EndNote files.

4. On the final “EndNote X is Successfully Installed” dialog,
click Finish to close the installation program, or click Run to
start EndNote.

To make sure the program installed correctly, see “Checking
Your Installation” on page 18.

Although we recommend that you use the Complete installation
option to install EndNote, the Custom installation option can be
useful if you are low on disk space or if you need to reinstall just
certain EndNote components.

To do a new custom installation:
1. Follow the instructions for “Installing EndNote” on page 13.
2. On the dialog titled “Select Installation Type,” select Custom.

3. When you get to the dialog titled “Select Components,” read
the section below, “Selecting Components” to determine
what you would like to select/deselect for installation.

14 Chapter 1: Windows EndNote Installation



NOTE: If the installer detects another copy of EndNote in the
destination folder, it gives you options to either backup or remove older
files during the installation. When doing a custom install, only selected
components are affected. For example, if you are installing only the
Anthropology styles, and you choose to remove older files, only the
older Anthropology styles are removed; no other part of the installation
is affected.

Selecting
Components

To install components after EndNote X is already installed:

1. Start the installation program as you would for a new
installation.

2. On the “Application Maintenance” dialog, select the Modify
option and click Next.

3. When you get to the “Select Components” dialog, read the
section below, “Selecting Components” to determine what
you would like to select/deselect for installation.

There are several major categories of components that can be

installed with EndNote.

The components you can select for installation include:
EndNote Application

EndNote Program

EndNote Help

PDF Manual

Additional Converters

* & & o o

Sample Files

Word Templates/Add-ins:

4 Add-in for Microsoft Word

¢ Templates for Microsoft Word

Styles: These formats for creating bibliographies are
grouped by type.

Connections: These files for directly retrieving references
from online reference databases are grouped by information
service provider.

Filters: These files for importing text files of reference data
are grouped by information service provider.

Spelling Dictionaries: These are dictionaries available for
the spelling checker.
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EndNote for Palm OS®: These are files required for using
EndNote for the Palm operating system.

To select or deselect an item for installation:

Click the plus sign next to each category to display a detailed list
of items. For each category or subcategory, click the triangle next
to the name to select from the available installation options. The
options may include:

Will be installed on local hard drive.

Entire feature will be installed on local hard drive.
Will be installed to run from network.

Entire feature will be installed to run from network.
Feature will be installed when required.

L 2R 2R 2R 2R R 2

Entire feature will be unavailable.

Upgrading from an Earlier EndNote Version

Backing Up or
Replacing
Files

Before you begin, back up any custom styles, import filters, and
connection files that you do not want overwritten.

While it is not required, we recommend that you uninstall any
earlier version of EndNote before you install EndNote X. See
“Uninstalling EndNote” on page 20.

During installation, you will need to enter both your new
EndNote X serial number, which appears on the EndNote
registration card or on the confirmation of your online order, and
your old EndNote serial number.

Install the upgrade just as you would a new installation. See
“Installing EndNote” on page 13. By default, EndNote X is
installed into the C:\Program Files\EndNote X folder.

If Setup detects an earlier copy of the EndNote program in the
installation folder, it alerts you and gives you two options. If you
continue with the installation to install EndNote X into your
existing EndNote folder, Setup removes the older EndNote
application and word processor support files. You need to select
what it should do with the styles, filters, and connection files
from your older copy of EndNote. No matter which option you
choose, your libraries will not be deleted; nor will any non-
EndNote files in the EndNote folder.
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¢ Backup older files: EndNote X provides complete, updated

sets of style, filter, and connection files. But if you want to
keep any of your older modified files to use with EndNote X,
you should choose this option. Doing so has EndNote create
a “Backup” folder in the EndNote folder and all of the styles,
filters, and connection files from your older installation are
copied into that folder. After installing EndNote, you should
move any of these files that you want to use into the Styles,
Filters, or Connections folders installed with EndNote X.

Remove older files: If this option is selected, Setup replaces
all of the styles, filters, and connection files from your
existing EndNote installation with the new ones included
with EndNote X. Do not choose this option if you have
custom styles, filters, or connection files that you want to
save. If they have the same names as any of the files to be
installed, the installer will overwrite them with the new files.

NOTE: Cite While You Write support is linked to only one copy of the
EndNote program, and only one instance can be used at one time. If
you install the Cite While You Write Add-in, it will replace an older
version even if you install EndNote in a separate folder.

Opening and
Converting
Old EndNote

Libraries

EndNote X automatically converts libraries created with earlier
versions of Endnote to the version 8/9/X format.

To convert an older EndNote library:

1.
2.
3.

Start EndNote.
From the File menu, select Open and then Open Library.

On the file dialog, locate and highlight the old library, and
click Open.

EndNote will warn that the selected library was created with
an older version, and will ask for permission to convert it.

Click OK to convert the library. Name the new library and
click Save. The conversion makes a copy of the original library
in the version 8/9/X format, and leaves the original library
intact.

NOTE: EndNote X libraries cannot be opened and used with versions
of EndNote prior to version 8.
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Using Old
Style, Filter,
and

Connection
Files

You may have created custom content files with an earlier
version of EndNote. EndNote X can use your custom styles,
filters, and connection files that were created with EndNote
versions 4.0.1-9. Once you edit and save one of these files with
EndNote X, it is converted to the version 8/9/X format.

All of the styles, filters, and connection files supplied with
EndNote X have been updated to the version 8/9/X format. The
new filter and connection files can be used by previous versions
of EndNote, with new fields simply ignored. However, EndNote
8/9/X styles cannot be used with versions of EndNote prior to
version 8.

Checking Your Installation

Checking
Microsoft
Word Support

To run EndNote, click the Start button, choose Programs, select
EndNote, and then choose EndNote Program.

A dialog will ask you to open a reference library file. Choose
Cancel. To check the version number of EndNote, choose About
EndNote from the Help menu. Click the splash screen to clear it.

If you have trouble accessing the program, repeat the installation
steps to verify that the program was correctly installed.

To see whether Cite While You Write is correctly installed, start
Word.

In Word 2000, XP, or 2003, click on the Tools menu and you
should see EndNote commands on an EndNote X submenu.
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Word 2000, XP, or 2003 Tools menu and EndNote X submenu
Tools |

[ enduotex v

€} Find Citation(s)...

% speling and Grammar... F7 Go To EndMote
i
=
4.

Templates and Add-Ins... Format Bibliography. ..

Customize. .. t* Insert Selected Citation(s)

Options... :f: Edit Citation(s)...

¥

é Insert MNote...

§£ Edit Library Reference(s)

E‘)J Unformat Citation(s)

¥y Remove Field Codes

Export Traveling Library. ..

fig. Find Figure(s)...

o Generate Figure List

% Cite While You Write Preferences. ..

7 Hep

NOTE: If you have trouble installing Cite While You Write support, see
“EndNote Commands Do Not Appear on Word’s Tools Menu” in the
Troubleshooting appendix of the full manual (EndNote.PDF found in
your EndNote folder).

Automatically Updating Files

You can automatically update EndNote X when incremental
program enhancements are available.

To update your copy of the EndNote program:
1. Open a connection to the Internet.
2. From EndNote’s Help menu, select EndNote Program Updates.

The wizard checks for an update, lets you know whether an
update is available, and then downloads the file(s) and applies
the update to your EndNote installation.

NOTE: You also have the option to download the latest content files at
any time from our Web site at http://www.endnote.com. We continually
update output styles, filters, connection files, and Microsoft Word
templates.
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Uninstalling EndNote

Uninstall EndNote by using the “Add/Remove Programs”
function in the Windows Control Panel.

NOTE: For network installations, see Chapter 20, “Using EndNote On
a Network” in the full manual.

To uninstall EndNote:

1. From the Windows Start menu, select Control Panel, or
choose Settings and then Control Panel.

2. Select Add or Remove Programs.
2. In the list of currently installed programs, select EndNote X.
3. Click the Remove button.

Or, you can uninstall by using the EndNote installation
program:

1. From your EndNote CD, run Setup.exe.

2. Onthe “Application Maintenance” dialog, select Remove and
click Next.

3. Click Next again to begin removing EndNote.

The uninstall procedure removes only files, groups, and icons
installed by the EndNote installer the last time it was run. For
example, if you used the installer’s Custom installation option to
reinstall only style files, the Uninstall program removes only
style files.

It will not delete your libraries or any new files you have created.
It will not delete folders if they contain files you created. You will
need to manually delete those files with Windows Explorer.
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Chapter 2: Introduction to an EndNote Library

This chapter covers the basics of working with EndNote. In
particular, you will learn how to:

¢ Start EndNote and open a library.
Sort the reference list.
Select and open references in the EndNote library.

Close references.

* & & o

Quit from the EndNote program.

Start EndNote To start the EndNote program and open the sample library:

1. From the Start menu, choose Programs, select EndNote, and
then choose the EndNote Program. A dialog appears
prompting you to open a reference library.

@ B

EndNote X 53
Get Started with Endiote X

43 (O Create a new EndNote library
-

@ () see what's new in EndNote X

é? (%) Open an existing EndMote library:

C:\Program Files\,.. \Paleo.enl w

oo not display this message again

[ OK H Cancel ]

NOTE: If you have set a default library to open automatically, that
library will open instead of the dialog shown above. If this happens,
close the library, choose Open from the File menu, and continue with
step 3.

2. Select Open an existing EndNote library.
3. To open the library, do one of these:
¢ Select Paleo.enl in the drop-down list, and click OK.

¢ If Paleo.enl does not appear in the drop-down list, click
Browse to locate it. A file dialog will appear, prompting
you to locate and open a reference library.
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Use the “Look in:” list to find the EndNote X folder. By
default, this will be on the C drive in the Program Files
folder. To get there, click the “Look in:” list, choose the “C:”
drive and click Open; select Program Files and click Open;
and then select and open the EndNote X folder.

Select the Examples folder and click Open. You should now
see the file “Paleo.enl,” the example EndNote library. (Your
folder View settings may or may not be set up to show the
extension .enl.) Select Paleo.enl and click Open.

e
My Recent
Documents

m

Desklop

9

My Documents
Computer

gl

My

by Metwork,

Look in: | I Examples

[C)palen.Data
Paleo.enl

File name:

Filez of type:

J =

| Libraries [*.enl;* i)

v | [ Cancel ]

NOTE: You can open a library from within EndNote by choosing Open
from the File menu.
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The Library
Window

When you open the Paleo library you see the Library window
listing all of the references that the library contains:

Move column dividers to adjust column widths

il Paleo.enl E—I@|g|
B 3 Author Year Title Journal/Secondary Title' Ref Type URL =
o Boltzmann's Constant (k) Equation
1971 Valdez v. Black F.2d Case
1974 Geophysical Research Letters Sedimentary Geology ~— Generic
1990 New Mexico Geological Soci... Generic
1994 National Environmental Polic.. U.S.C. Statute
1997 Exchange of ideas and infor.. Committee on Energy... Hearing http:/fene
1998 Eocene fossils Web Page http:/iww
1999 Sequoia Ecosystem and Re. .. Bill
Allen 1988 Modern-period muddy sedim... Sedimentary Geology  Journal Article
Alvarez 1984 Evidence from crater ages fo... Nature Journal Article
American... 2002 Vertebrate Evolution Web Page http:/iww
Angell 1988 Relation of Antarctic 100 mb ... Geophysical Researc... Journal Article v
< >
Mo References Selected
Showing 206 out of 206 references. & Hide Preview

Preview
References

The Library window displays a multi-column list. By default, the
first column shows a paper clip for references that include
attached graphics, figures, or files. The second column shows a
PDF icon for references that include an attached file such as a
PDF. Then, the first author’s last name, the year, the title, the
reference type, and the URL are displayed for each reference.
The information displayed here in the Library window, as well
as the font used for the display, can be changed using the
EndNote Preferences.

You can browse through your reference library by first selecting
areference, and then using the scroll bar, the scroll arrows, or the
PAGE DOWN, PAGE Upr, HOME, END, and ARROW keys.

You can easily see more detail about a reference by highlighting
the reference and viewing the Preview pane at the bottom of the
Library window.

To preview a reference:

1. First, if you do not have a lower pane in the window, click on
the Show Preview button at the bottom of the window.

2. For this example, click on the reference titled “Geophysical
Research Letters.”
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The preview pane uses the current output style to display
the selected reference as it will be formatted for a
bibliography. EndNote’s output styles (or just styles)
represent the rules for creating bibliographies for a variety of
journals and other publications. The styles determine how
your references look when you print, export, preview, or

create bibliographies.

To select a different output style to apply to the reference, go
to the main toolbar and select Numbered from the drop-down

list of output styles.

File Edit References Tools Window Help

eSS BN BE WY

Murnbered v

-

,_,
o

s
111

= Select Another Style...
= &nnotated
Author-D ate

Endtate Expart

Show Al

Only one reference is displayed in the preview pane at a time. If
multiple references are selected, only the last one is displayed.

The format of the reference in the preview pane can be changed
at any time by choosing a different output style.

¢ Paleo.enl
B B Author

Year

1971

Title

Boltzmann's Constant (k)
Valdez v. Black

Geophysical Research Letters

Journal/Secondary Title ' Ref Type

F.2d

Sedimentary Geology

EBX

URL
Equation

Case
Generic

-

1990 New Mexico Geological Soci... Generic
1994 National Environmental Polic.. U.S.C. Statute
1997 Exchange of ideas and infor..  Committee on Energy... Hearing http:/h
1998 Eocene fossils Web Page http:/h
1999 Sequoia Ecosystem and Re. .. Bill
Allen 1988 Modern-period muddy sedim... Sedimentary Geology  Journal Article
Alvarez 1984 Evidence from crater ages fo... Nature Journal Article
American... 2002 Vertebrate Evolution Web Page http:/h
Angell 1988 Relation of Antarctic 100 mb ... Geophysical Researc... Journal Article v
>
Geophysical Research Letters, in Sedimentary Geology. 1974, American Geophysical Union:
Washington, D.C.
Showing 206 out of 206 references. & Hide Preview

When the preview pane is showing, a Hide Preview button is
available at the bottom of the window. You can click Hide Preview
to hide the preview pane if you wish. The name of the button will
toggle to Show Preview.
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Sort the
References

¢ Paleo.enl

References can be easily sorted by clicking on the column

heading (such as Author, Year, or Title).

To change the sort order:

1.

Click the Author column heading to change the current
Author sort from ascending order to descending order.

CEX

0 & Author Year Title Journal/Secondary Title  Ref Type URL*™
BREEE... 1981 F=ie| [ WES [ iHmie... KRB 2=, Book
SR L 1998 20 Fe )L o Book
Zartman 1988 Appalacian geo-chronology Geological Society of ... Journal Article
Wrona 2004 Kambryjskie mikroskamieniat... Acta Palaeontologica ... Journal Article httpy
Wolfe 1990 Palaeobotanical evidence fo... Nature Journal Article
Whitney 1997 Evidence for Triceratops in A... New Directions in Pale... Book Section
Whiting 1987 Herding instincts of cretaceo... Journal of Paleontology  Journal Article
Wells 2001 Science fiction classics Audio book collection Audiovisual ...
Waters 2000 CLO and O3 stratospheric pr... Geophysical Researc... Journal Article

-
>

1. BRHKEEELR W FT_EFTEH, EATHBLEATESEREN, # 4 X HTETIHES
DF I IEGEE 20T REEEEI AL EERS 0K Vol. 3. 1981, R: REHHE TS

HESBLE. 112.

Showing 206 out of 206 references.

4 Hide Preview

NOTE: This example shows references that include Japanese
characters. EndNote uses Unicode to encode special characters, so

that data is easily translated between platforms, programs, and

languages. If boxes appear instead of characters, you may need to
change the EndNote display fonts to a Unicode font. You will learn how
to do this in the next chapter, “Setting EndNote Preferences.”

Click the Year column heading to see the references sorted in
ascending order based on the year of publication.

Click the Year column heading again (a second time) to

reverse the sort order and see the references sorted in

descending order.

Now, click the Author column heading to return the sort
order of the library to an alphabetical list sorted by the
author names. You may need to click the heading twice to
return to ascending order.

Chapter 2: Introduction to an EndNote Library
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Select and
Open a
Reference

To work with specific references you must first select them in the
Library window.

There are different ways to select a reference, such as clicking on
the reference using the mouse, using the arrow keys, or typing
the first few letters found in the field by which the library has
been sorted.

To see how this works, click once on any reference to select it. If
you have arrow keys on your keyboard, press the UP or DOWN
ARROW to select the previous or next reference. When the library
is sorted by author name (as it should be now), you can also
select a reference by typing the first few letters of the author’s
last name.

To quickly find and display a reference:

1. Select the first Argus reference in the list by typing “arg”
without pausing between letters.

¢ Paleo.enl
B B Author

Allen
Alvarez
American...
Angell
Apollonov
Archaeos. ..

FBEX
Year Title Journal/Secondary Title ' Ref Type URL »
1990 New Mexico Geological Soci... Generic
1994 National Environmental Polic.. U.S.C. Statute
1997 Exchange of ideas and infor.. Committee on Energy... Hearing http:/h
1998 Eocene fossils Web Page http:/h
1999 Sequoia Ecosystem and Re. .. Bill
1988 Modern-period muddy sedim... Sedimentary Geology  Journal Article
1984 Evidence from crater ages fo... Nature Journal Article
2002 Vertebrate Evolution Web Page http:/h
1988 Relation of Antarctic 100 mb ... Geophysical Researc... Journal Article
1988 Batyrbay section, South Kaz .. Geological Magazine Journal Article
1999 Preliminary Site Report of th. .. Web Page http:/h

New paleontological excavat...

Journal of Paleontology

Journal Article

1. Argus, M.V, New paleontological excavation techniques. Journal of Paleontology, 1993. 19: p. 234-237.

Showing 206 out of 206 references.

4 Hide Preview
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Now that the reference is selected, there are a number of
things you can do with it, such as view its contents, copy, cut,
delete, or edit it. For now, just open the reference to view the

contents.

Open the selected Argus reference by pressing the ENTER key
or by using the Edit command on the References menu. You
can also open a reference by double-clicking on it in the

Library window.



title bar

Close the
Reference

The Reference window opens to display all of the information
associated with the reference.

«#| Argus, 1993 #34 (Paleo.enl) close

[El P Reference Type: Jourmal Article + | 4 Hide Empty Fields button

Author e’

lArgus, Michele V.

Year

1993

Title

New paleontological excavation techniques

Journal
Journal of Paleontology

Volume

19

Issue

This is where you enter or edit information for a reference. The
citation information is displayed at the top of the Reference
window in the title bar, “Argus, 1993 #34.” This information—
the first author’s last name, year, and record number—is used by
EndNote to match citations in a paper to references in a library.

To view the rest of the reference, use the mouse to scroll down
the Reference window, or press the TAB key to move forward
from one field to the next. Press SHIFT+TAB to move backwards
through the fields.

The window may also be resized by clicking and dragging the
lower right window corner. To reposition the window, click on
the title bar and drag the window to the desired location.

Next, close the reference. You can do this in one of these ways:

¢ Click the close button in the upper corner of the Reference
window.

¢ From the File menu, choose Close Reference.

¢ From the keyboard, press CTRL+W. Note that many of the
menu commands have a keyboard equivalent next to them.

EndNote automatically saves all changes to a reference when the
Reference window is closed.

If you do not want to continue with the next chapter (Setting
EndNote Preferences), go to the File menu and choose Exit to
close the program. Otherwise, continue with the tour.
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Related See these sections in the full EndNote.PDF manual for
Sections in the information related to this portion of the tour:

Full Manual ¢ Learn how to change the display of the Library window in
Chapter 4.

¢ To learn more about sorting, see “Sorting the Library” in
Chapter 8.
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Chapter 3:

Open the Paleo
Library

Access
EndNote
Preferences

Set a Default
Library

Setting EndNote Preferences

In this part of the guided tour you will learn how to:

¢ Display EndNote Preferences

¢ Set a default library to open each time you start EndNote.
¢ Change the display fonts.

If EndNote is not already running, start it and open the Paleo
library as shown under “Start EndNote” on page 21.

To view or change the EndNote preferences:
From the Edit menu, choose Preferences.

Many of these preferences are stored in your Windows registry,
although there are exceptions.

You can assign a library to open automatically every time you
start EndNote. You will find it useful to set the Paleo library
(Paleo.enl) as your default library for now. Later, when you
create your own library, you can set it as the default library.
To set a default library:

1. If you haven't already, go to the Edit menu and choose
Preferences.

2. In the list on the left, click Libraries.
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Change the

Library

Display Font

30 Chapter 3: Setting EndNote Preferences

3. Click Add Open Libraries. You should see the Paleo library

EndNote Preferences

Display Fonts
Reference Types
Temporary Citations
Sorting

Change Case
Formatting
Display Fields
Duplicates

Online

Folder Locations
Term Lists

Spell Check
OpenlURL/PDF

(Paleo.enl) listed at the top of the window.

Open the following libraries when EndMote starts:

C:\Program Files"EndMote X'\Examples'.Palec.enl

[ Add Open Libraries ] [ Remove Library

Show Library Name in Reference Window

[EndNote Defaults] [ Revert Panel ] [ oK ] [ Cancel ] [

Aoply |

4. Click Apply to save this change.

While you could click OK to save the change and leave the
Preferences dialog, we are going to change another preference

first.

Next, pick a different font to display text in the Library window
and the Reference window.

To change the display fonts:

1.

In the list on the left, click Display Fonts.

If you aren’t currently viewing the EndNote Preferences
window, go to the Edit menu and choose Preferences.

The Library Display Font determines the font and size of the
references listed in the Library window.

The General Display Font changes the font used to display
all other text that is typed into EndNote (such as in the
Reference or Style windows). The General Display Font is
also used for most of the previews and information panels in



Related

EndNote, as well as for bibliographies that are printed or
copied directly from EndNote.

=

EndNote Preferences

Libraries
Library Display Font
Reference Types
Tempaorary Citations |Aria|. 12pt Change Fort...
Sorting
Change Case These settings change the font and size #
e of the text displaved in the Library L/
Display Fields
Duplicates General Display Fort
Online
Folder Locations -
Arial, 1
S ——— | al, 12pt Change Fort...
zpell E:EL?DF These settings change the display of all »
enl . : .
P text entered in the Plain Font and Plain *
[EndNote Defaults] [ Revert Panel ] [ QK ] [ Cancel ] [ Apply ]

Under Library Display Font, click the Change Font button.

In the Font list, select Arial Unicode MS (or another Unicode
font that supports Japanese characters) and click OK to save
the change.

EndNote uses Unicode to correctly handle extended
characters. By selecting a Unicode font here, you can view
extended characters in the Library window, such as the
Japanese characters found in the Paleo library.

Under General Display Font, click the Change Font button.

In the Font list, select Arial Unicode MS (or another Unicode
font that supports Japanese characters) and click OK to save
the change.

Click OK to save your changes and leave the Preferences
dialog.

See these sections in the full EndNote.PDF manual for
information related to this portion of the tour:

Sections in the
Full Manual

¢ Learn how to change the display of the Library window in

Chapter 4.

¢ The Preferences panels provide numerous ways in which

you can customize your version of EndNote. For example,
you can ignore articles when sorting, set duplicate detection
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options, etc. See Chapter 18 for more information about
working with the preferences.
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Chapter 4:

Open the Paleo
Library

Create a New
Reference

Entering References

In this part of the guided tour you will learn how to:
¢ Enter references into a library.
¢ Insert picture files and object files into references.

In this part of the tour, you are going to enter references: first a
typical book reference, and then references that contain images.

If EndNote is not already running, start it and open the Paleo
library (Paleo.enl), as shown under “Start EndNote” on page 21.

There are various ways to add references to an EndNote library:
¢ Type the reference information into the Reference window.

¢ Connect to an online bibliographic database and retrieve the
references directly into EndNote, as demonstrated in
Chapter 5: "Searching Remote Databases".

¢ Import text files of references that have been downloaded
from online bibliographic databases or CD-ROMs, as
demonstrated in Chapter 6: "Importing Reference Data into
EndNote".

This example demonstrates how to type reference information
into EndNote.
Once a library is open, you can add a new reference to it:

1. From the References menu, choose New Reference (CTRL+N).
An empty Reference window opens with the words “New
Reference” displayed at the top.

=

«#d| New Reference (Paleo.enl)

Reference Type: | Joumnal Aticle - Reference
Type list

Author e’

Year

Title

Journal

Volume

Issue
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New references appear as journal articles (unless you change
the default setting) but can be changed to any other type of
reference using the Reference Type list at the top of the
Reference window. For this example, create a Book
reference.

2. Click the Reference Type list and choose Book.

=

«#d| New Reference (Paleo.enl)

Reference Type: Book - Reference

Type setto
Author “Book”

¥

Year

Title

Series Editor

Series Title

City

v

You are now ready to enter reference information, beginning
with the author names. Author names can be entered two
ways: either “First Middle Last” such as “Carol Margaret
Jacobson” or “Last, First Middle” such as “Jacobson, Carol
Margaret.” Individual author names must be entered one per
line.

3. With the cursor in the Author field, type:
Jacobson, Carol

As you type, EndNote will suggest names similar to the one
you are entering. This is EndNote’s way of using term lists
to facilitate the process of entering new references.

NOTE: The auto-complete feature can be turned on or off with EndNote
Term List preferences. It is available for Author fields when you enter
author names with the last name first.

4. The name you are entering, Carol Jacobson, is a new author
in this library, so keep typing until you complete the name
and then press the ENTER key.

The name appears in red text to indicate that it is a new name
in the Author term list for this library. When you close the
reference, it will be added to the Author term list and the red
text will change to black. You can read more about term lists
(and how to turn these options on or off) in Chapter 9 of the
full manual.
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Now enter the second author’s name:
Roe, Jennifer

This author is already in the Paleo library, so as you start
typing the last name, you will see EndNote complete the
name for you.

=

«#d| New Reference (Paleo.enl)

Feference Type: |Book V|

Author
Jacobson, Carol

[ Jennifer

Year

Title »

Press the TAB key to accept EndNote’s suggested author
name, and move to the Year field. In the Year field, type:

1999

Continue entering the reference as shown below, using the
TAB key to move to the next field, and SHIFT+TAB to move to
the previous field, if necessary. You can also use the mouse
to click in the desired field. If information is not provided for
a particular field, leave that field empty.

Title: Impacts of meteorites on Earth
City: New York
Publisher: Blackcourt Press

Number of Pages: 100
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Abstract: The impact of a meteorite hitting
earth millions of years ago may have led to
the extinction of some marine life.

«#d| New Reference (Paleo.enl)

Feference Type: | Boak ' |
Author e
Jacobson, Carol
Roe, Jennifer
Year
1999 .
— This book does
: not have a
Impacts of meteorites on Earth A Y
. Series Editoror
Series Editor a Series Title,
so those fields
Series Title are left empty.
City
New York
Publisher
Blackcourt Press v

No extra punctuation (such as parentheses around the year)
or text styles (such as bold or italic) are entered into the
reference. EndNote adds the necessary punctuation and text
style changes to the references when it creates a
bibliography.

It is best to enter English titles in sentence case, where only
the first word and proper nouns are capitalized. The selected
output style can then either print the text as entered
(sentence style) or apply headline case, where all major
words are capitalized (excluding articles and prepositions).

7. Close the Reference window by clicking the close box, or by
choosing Close Reference (CTRL+W) from the File menu.
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All information is automatically saved when you close a
window. Your new reference will appear in the Library window.

#| Paleo.enl E|@|Fz|
B B Author Year | Title Journal/Secondary Title| Ref Type URL #
Hall 1999 Late Bajocian and Bathonian... Journal of Paleontology Journal Article
Hanson 1999 Laboratory studies of the nitri... Geophysical Researc... Journal Article
Harred 1972 Epoxidation process Patent
Havholm 1988 A preliminary study of the dy...  Sedimentology Journal Article
Herzog 1999 Influence of inertial forces on ... Comptes rendus des ... Journal Article
o Hill 2005 Geologicaltime scale—are.. Excel Chart or Table
Hoare 1998 Preserved color patterns on ... Journal of Paleontology  Journal Article
Hsieh 1988 A modelfor the spatial and e.. Geophysical Researc... Journal Article
Hut 1985 Comet showers as possible .. Eos Journal Article
lzbicki 2000 Infiltration of water through thi_.. Dissertation Abstract...  Journal Article
lzett 1987 Authigenic "spherules” in K-..  Geological Society of .. Journal Article
Jacobson 1999 Impacts of meteorites on Earth Book v
< >
1. Jacobson, C. and J. Roe, Impacits of meteorites on Earth. 1999, New York: Blackcourt Press. 100.
Showing 207 out of 207 references. & Hide Preview

Enter
References
That Contain
Images

EndNote helps you organize both reference information and
images. Three reference types—Figure, Chart or Table, and

Equation—are available specifically for cataloging picture files
and object files, although you can add Images and Captions to
any reference type.

The difference between a picture file and an object file is how
Word interprets the file. For example, Word interprets files with
these extensions as pictures:

¢ BMP Windows Bitmap
¢ GIF Graphics Interchange Format
¢ JPEG JPEG File Interchange Format
¢ PNG Portable Network Graphics
¢ TIFF Tag Image File Format
A file that is not recognized as a picture file is considered an

object file. In this section, you are going to enter a journal
reference that includes a picture file.

To enter a reference that includes an attached picture file:

1. From the References menu, choose New Reference (CTRL+N).
An empty Reference window opens with the words “New
Reference” displayed at the top. The Reference Type should
appear as Journal Article.

2. Enter the reference as shown below, using the TAB key to
move to the next field, and SHIFT+TAB to move to the
previous field, if necessary. You can also use the mouse to
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click in the desired field. If information is not provided for a
particular field, leave that field empty.

Author: Tiberius Rex
Year: 1995

Title: The scale and the feather--a suggested
evolution

Journal: Paleontology
Volume: 23

Issue: 9

Pages: 23-45

Keywords: Feathers
Evolution
Birds

Abstract: This article discusses the
evolution of bird feathers from reptilian
scales.

Scroll down to the Image and Caption fields.

4. From the References menu, select Insert Picture to display a
file dialog.

5. On the file dialog:

a. Navigate to the folder: Program Files\EndNote X\
Examples.

b. Highlight the file titled Feather2.BMP.
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c. Click Open to insert the file into the Image field.

=

#1| New Reference (Paleo.enl)

Reference Type: | Journal Article ™ |

Author Address =

Image

Caption

Access Date -

Last Modified Date "

The graphic appears as a thumbnail in the reference.
EndNote copied the file to a .DATA folder stored with the
Paleo library, and linked the copied graphic to this reference.

In the Caption field, enter:
Cockatiel Crest Feathering

Always enter a caption for your image. It assists in locating
images, and it labels figures in your Microsoft Word
documents.

Click the close button to close and save the reference and
return to the library window.

Next, enter a reference that includes an attached object file:

1.

From the References menu, choose New Reference (CTRL+N).
An empty Reference window opens.

Click the Reference Type list and choose Chart or Table.
Enter the reference text as shown below.

Created By: Milkirk, Marie

Year: 2002

Title: Hominid Timeline

Image Source Program: Microsoft Excel
Date: May 9

Keywords: Evolution
Hominids
Timelines

Chapter 4: Entering References 39



40

Scroll down until you can see the Image field, and from the
References menu, select Insert Object.

@ o
Insert Object fgl
File name:
| | Choosze File...
M ote:

an Object Reference in your End Mate Library:
M5 Excel Chart, M5 Excel Workshest, M5 Visio
Drawing, M5 PowerPaint Slide or Presentation.

@ “t'ou may ingert any of the following file types into

Click Choose File to display a file dialog.
On the file dialog:

a. Navigate to the folder:
Program Files\EndNote X\Examples.

b. Highlight the Microsoft Excel file titled
Hominid Evolution.xls.

c. Click Open to insert the file into your new reference.

«#d| New Reference (Paleo.enl) [ZI[EI[XI

Feference Type: |Ehart or Table V|

Author Address
Ima%e

Caption

Access Date

Last Modified Date

Translated Author

The file appears as an attachment in the Image field.
EndNote copied the file to the .DATA folder stored with the
Paleo library, and linked the copied file to this reference.

In the Caption field, enter:
Hominid Timeline

Click the close button to close and save the reference and
return to the library window.
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To easily locate the references containing images:

Click on the Image column heading (the paper clip) twice to sort
records containing images at the top of the list.

il Paleo.enl
0 & Author Year Title Journal/Secondary Title  Ref Type URL #
0 Boltzmann's Constant (k) Equation
o National ... Bird evolution Figure
o MacRae 2002 Marrella splendens Figure
o Hill 2005 Geological time scale—ar... Excel Chartor Ta...
o Rex 1995 The scale and the feather--... Paleontology Journal Article
o Milkeirk 2002 Hominid Timeline Microsoft Excel Chartor Ta...
RE#HH. 1981 FIT-SETEH; HH.. REFEFEHE.. Book
AF- .. 1998 {ERASHDE NDEL Book
Zartman 1988 Appalacian geo-chronology  Geological Society of ... Journal Article
Wrona 2004 Kambryjskie mikroskamien... Acta Palaeontologica ... Journal Article hitp:/i«
< >

1. Baltzmann’s Constant (k).

Showing 209 out of 209 references. & Hide Preview
You can double-click on an individual reference if you would
like to view the complete reference. When you are done viewing
a reference, click the close button to close it.

Click the Author column heading to again order the list by

author names in ascending (A to Z) order.

This concludes Chapter 4 of the guided tour. Chapter 5

demonstrates how to search remote databases and save your

search results to an EndNote library. If you do not have an

Internet connection, skip Chapter 5 and move on to Chapter 6:

"Importing Reference Data into EndNote" on page 51.

If you are finished working with EndNote for now, go to the File

menu and choose Exit to close the EndNote program.
Related See these sections in the full EndNote.PDF manual for

Sections in the
Full Manual

information related to this portion of the tour:

¢ If you are eager to begin creating your own library, see
Chapter 4, “Introducing the EndNote Library.”

¢ Chapter 5, “Entering and Editing References,” provides
more detail about typing references into your library and
inserting images.
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Chapter 5: Searching Remote Databases

With the EndNote Connect and Search commands, you can search
online bibliographic databases just as easily as you can search an
EndNote library on your own computer! And to make it even
easier, the results of your searches appear as EndNote
references—ready for you to store in your own EndNote library.

This section will guide you through these basic steps:

¢ Connect to a remote database.
¢ Search the database.

¢ Copy the references that you want to keep into an EndNote
library.

NOTE: In order to follow along with this exercise, you must be at a
computer with access to the Internet (either dial-up or a direct network
connection).

About the PubMed Database

For this lesson, you will connect to PubMed, the National Library
of Medicine’s online public access version of their MEDLINE
database. PubMed is the remote database you will be searching;
the National Library of Medicine is the information provider.

For Users With “Dial-up” Internet Connections

If you use a modem and a phone line to connect to the Internet,
as opposed to a direct network connection, this section pertains
to you.

Connecting: Most setups for dial-up connections are configured
to automatically dial your information provider and connect to
the Internet when you use an application that requests an online
connection (as EndNote’s Connect command does). However,
some setups require that you establish an online connection (sign
on) before choosing EndNote’s Connect command.

Disconnecting: EndNote will not disconnect your Internet
connection at any point. You need to shut down your connection
when you have finished using EndNote’s Connect feature.
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Open the Paleo
Library

Connect to a
Remote
Database

If EndNote is not already running, start it and open the Paleo
Library (Paleo.enl), as shown under “Start EndNote” on page 21.

The first step in searching a remote database is connecting to it,

so that is how we will begin.

To connect to the PubMed Database:

1. With EndNote running, go to the Tools menu, select the
Connect submenu, and select Connect.

(The Connect menu will remember databases you have
connected to in the past for easy access. You can also
customize a list of favorite databases to search.)

Choose A Connection File

Name Information Provider L
Princeton U Library Catalogs
ProGuest ProGuest
PsycARTICLES (OCLC) OCLC
PsycBOOKS (OCLC) OCLC FirstSearch
PsycFIRST (OCLC) OCLC
PsycINFO {C5A) CSA
PsycINFO (EBSCO) EBSCO
PsycINFO (OCLC) OCLC
PsycINFO {OVID) Ovid
PsycINFO (SF) SilverPlatter
Public Library Catalog (WW) WilsonWeb
Public Library Catalog Arch (WW) WilsonWeb
Purdue U Library Catalogs
Queen Margaret U Coll Library Catalogs v
Find [ Cancel ] [ Connect ]
clicktoshow 1, ..o
more or less
info about File Name: PubMed (NLM) 2nz
the selected Created: Thursday, March 23, 2006, 2:08:48 PM
connection Modified: Thursday, March 23, 2006, 2:08:48 PM
file Based On:
Category: NLM

Commerts: |This js an HTTP-based connection file for 4
the National Library of Medicine's PubMed

Showing 812 of 812 connection files from C:\Program Files\EndMote X\Connections,

NOTE: This window displays all of the connection files available in your
Connections folder. Use the Find button to quickly view various
categories of databases to help you locate the one that you need.

2. Select the PubMed connection file (you can start typing the
file name to quickly jump to it in the list), and click Connect.

By selecting that connection file, you have directed EndNote to
connect to the National Library of Medicine’s PubMed database.
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If for any reason the connection cannot be established, EndNote
alerts you with an error message and closes the connection.

When the connection has been established, EndNote opens a
Retrieved References window for the PubMed Database, and
displays the Search window on top of it. Note that the search
window is titled, “Remote Search PubMed MEDLINE At
PubMed (NLM).” The PubMed MEDLINE database is selected
and EndNote is ready to search.

Retrieved
References
window " |.-'-\ny Field v| |C0ntains v| And W =
seac;’Ch | |.-'-\ny Field v| |C0ntains v| And W
window
| |.-'-\ny Field v| |C0ntains v| And v j
the remote - Search (Remote: PubMed MEDLINE ot PubMed (NLM) )| Search
database is A
selected for
searching
[ Save Search ] [ Load Search ] [ Set Default ] [Reshore Default]
m [ Add Field ] [ Insert Field ] [ Delete Field ] [ Insert Special ] ” 2
NOTE: If you previously set a default configuration for the Search
window, the search field lists display the fields you selected as your
defaults. If one of these fields appears italicized in the Search window
lists, that indicates it is not a valid option for the remote database.
Search the The next step is to enter the search term(s) to find the references
P
Database you need. Searching a remote database is very similar to

searching an EndNote library, with a few exceptions.

Let’s say you are interested in finding more information about
fossils for the Paleo library.
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To enter the search term(s) and perform the search:

1.

Enter “fossil” into the first search line and set the field list in
that line to Keywords (MeSH). The comparison list for remote
searches is always set to Contains.

-
«#1| Remote Search PubMed MEDLINE at PubMed (NLM)

Search In
' =TI comparison
fllgtld fossil Keywords (MeSH) Contains /v And W list P

| |.-'-\ny Field v| |C0ntains v| And W

| |.-'-\ny Field v| |C0ntains v| And v j

Search  |Remote: PubMed MEDLINE at PubMed (NLM) | [ Search | [ Close |

4 |less

[ Save Search ] [ Load Search ] [ Set Default ] [Reshore Default]

[ Add Field ][ Insert Field ][ Delete Field ][ Insert Special ]

2. Click Search.

EndNote sends the search request off to the remote database
(PubMed, in this example), and a summary of the search
results is displayed:

=

Confirm Remote Search

Found 3346 references.

Retrieve References From: B through  |3946

[ OK ] [ Cancel ]

The dialog displays the number of references that were
found to match your search request, and gives you the
option to retrieve them.

NOTE: PubMed is updated regularly, so you may find a different
number of references than illustrated here.

If the result set seems too big, you can always refine the
search to get closer to exactly those references you want.
Let’s refine this search by looking for just those references
that include mention of a “trilobite,” a group of extinct
marine animals that were abundant in the Paleozoic era.

Click Cancel, and you are returned to the Search window.
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Any Field.

«#1| Remote Search PubMed MEDLINE at PubMed (NLM)

Search In
[fossil |KEonrds (MesH) v| |Contains v| lAnd_v} =
|tri|0bite| |.-'-\ny Field v| |C0ntains v| And W
| |.-'-\ny Field v| |C0ntains v| And v j
Search  |Remote: PubMed MEDLINE at PubMed (NLM) | [ Search | [ Close |
4 |less
[ Save Search ] [ Load Search ] [ Set Default ] [Resmre Default]
B [ Add Field ] [ Insert Field ] [ Delete Field ] [ Insert Special ]
7. Click Search.
This time only 11 references were found.
-
Confirm Remote Search
Found 11 references.
Retrieve References From: i through .
[ OK ] [ Cancel ]
8. Click OK to retrieve the matching references.
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Click in the second search line and type “trilobite”.

Verify that the field list for the second search line is set to

Set the operator between the two search lines to And.

choose the
“And”
operator
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The references are downloaded and appear in the Retrieved
References window for the PubMed database connection.

] PubMed MEDLINE at PubMed (NLM) (=3
|D°”9 Copy All References To _
B B Author Year | Title Journal/Secondary Title | Ref Type URL

Simpson 2005 Development of the caudal e... Evolution & developm...  Journal Article http:/fwww.
Zhu 2004 Direct evidence for predation... Proceedings Journal Article  http:/iwww.
Fusco 2004 Exploring developmental mo...  The American naturalist Journal Article http:/iwww.
Fortey 2003 A Devonian trilobite with ane... Science Journal Article  http:/iwww.
Hughes 2003 Trilobite body patterning and ... BioEssays Journal Article  http:/iwww.

Sepich 2000 Role of the zebrafish trilobite .. Genesis (New York, N... Journal Article http:/iwww.
Wagner 2000 Exhaustion of morphologic c...  Evolution; internationa... Journal Article  http:/iwww.

Gal 2000 Image formation by bifocal le... Vision research Journal Article  http:/iwww.
Foote 1996 Fossil preservation and the s...  Paleobiology Journal Article  http:/iwww.
Horvath 1989 Geometric optics of trilobite ... Mathematical bioscie...  Journal Article http:/fwww.
Clarkson 1975 Trilobite eyes and the optics ... Nature Journal Article  http:/iwww.
< >
Showing 11 out of 11 retrieved references. ¥ Show Preview

You can halt a retrieval in progress by clicking the Pause button
on the Retrieved References window, or by pressing the Escape
key (EsC). The Pause button appears in the status line at the
bottom of the window during record retrieval.

You can drag the dividers between column headers to resize
column widths.

NOTE: If you wanted to do another search of PubMed at this point, you
could go to the Window menu and choose the Remote Search window
to display. Enter the new search strategy and click Search. On the
Confirm Remote Search window, you are asked, “Discard the
previously retrieved references?” You can either replace the current
search results or add to them.

Save the At this point you can peruse the retrieved references to see which
pomnty P

References ones you would like to keep. Save the references you want by
transferring them into one of your own EndNote libraries.

The selected references can be copied to an open library using
drag-and-drop or the Copy and Paste commands. You can also
copy references directly to a library that is open, to a library that
is closed, or to a new library using the Copy References To
command, as described below.

For this example, we will save two of the retrieved references to
EndNote’s sample Paleo library.
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To save your retrieved references:

1. Select two of the references displayed by holding down the
CTRL key and clicking on the individual references. (SHIFT-
click to select a range of references.)

#1| PubMed MEDLINE at PubMed (NLM)

|Done Copy 2 References To _

B B Author Year | Title Journal/Secondary Title | Ref Type
Simpson 2005 Development of the caudal e.. Evolution & developm...  Journal Article
Zhu 2004 Direct evidence for predation... Proceedings Journal Article
Fusco 2004 Exploring developmental mo...  The American naturalist Journal Arti
Fortey 2003 A Devonian trilobite with ane... Science Journal Article i |
Hughes 2003 Trilobite body patterning and ... BioEssays Journal Article  http:/iwww.
Sepich 2000 Role of the zebrafish trilobite .. Genesis (New York, N... Journal Article http:/iwww.
Wagner 2000 Exhaustion of morphologic c...  Evolution; internationa... Journal Article  http:/iwww.

Gal 2000 Image formation by bifocal le... Vision research Journal Article  http:/iwww.
Foote 1996 Fossil preservation and the s...  Paleobiology Journal Article  http:/iwww.
Horvath 1989 Geometric optics of trilobite ... Mathematical bioscie...  Journal Article http:/fwww.
Clarkson 1975 Trilobite eyes and the optics ... Nature Journal Article  http:/iwww.
< | >
Showing 11 out of 11 retrieved references. ¥ Show Preview

2. Click the Copy 2 References To button, and do one of these:

¢ If the Paleo library is already open and appears in the
list, select it.

¢ Or, select Choose Library. In the file dialog that appears,
open the Examples folder in the EndNote folder, choose
Paleo.enl, and click Open.

The references retrieved from the PubMed database are
copied to the selected library.

3. Close the Retrieved References window for PubMed.

EndNote alerts you that the references in the Retrieved
References window will be discarded.

4. Because you have already saved what you needed, you may
click OK and close the window. You will be disconnected
from PubMed.

5. Close the Search window.

This concludes the tutorial for using EndNote’s Connect
command.
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Related See these sections in the full EndNote.PDF manual for
Sections in the information related to this portion of the tour:

Full Manual ¢ See Chapter 6 for details about establishing connections,
searching for references, and retrieving references.

¢ Read “Selecting a Connection File” in Chapter 6 to learn
about the connection files that are available with EndNote.

¢ See “Troubleshooting Connections” in the Troubleshooting
appendix if you encountered any problems establishing a
connection.

¢ See Chapter 17, “Connection Files” for information about
creating and editing connection files.
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Chapter 6:

Open the Paleo
Library

Search the
Database and
Save the
References

Importing Reference Data into
EndNote

Remote searching, described in the previous section, is the
easiest way to retrieve references from online databases, but not
all information providers offer that option.

If you have access to an online bibliographic database, a
university catalog, or a bibliographic database on CD-ROM, you
can probably use EndNote’s import filters to import text files
saved or downloaded from these sources. EndNote filters are
configurable, so they give you the flexibility to import the
reference data you need and eliminate data you do not need.

In this part of the guided tour you will learn about:

¢ Downloading data in a tagged output format.
¢ Selecting an import filter and importing data into EndNote.

If EndNote is not already running, start it and open the Paleo
library (Paleo.enl), as shown under “Start EndNote” on page 21.

Often when you search a database, the matching references are
displayed as text, with no clear indicator between each piece of
bibliographic information. The PubMed reference below, saved
in a Citation format, is an example. There is no clear indicator for
EndNote to be able to differentiate a title from an address or an
abstract.

Am J Med Genet A. 2005 Mar 9; [Epub ahead of
print]

Reconstructing the behaviors of extinct
specles: An excursion into comparative
paleoneurology.

Rogers SW.

Salt Lake City VA-Geriatrics Research,
Education and Clinical Center and Department
of Neurobiology and Anatomy, University of
Utah School of Medicine, Salt Lake City, Utah.

How can the behavior of an extinct species
be reconstructed-say a dinosaur such as
Allosaurus? Despite the relatively abundant
fossilized remains of this and other

Chapter 6: Importing Reference Data into EndNote 51



dinosaurs, the incompleteness of the fossil
record has permitted room for considerable
speculation, mythology, and perhaps a bit of
unsettling reflection on what factors
contributed to the eventual fate of these
remarkably successful animals. (continued)
(c) 2005 Wiley-Liss, Inc.

PMID: 15759265 [PubMed - as supplied by
publisher]

To use this information effectively, each piece of bibliographic
information must be consistently tagged so it can be directed to
the correct EndNote field.

Database providers typically offer several different download
formats. Regardless of which system you are searching, you need
to save the references in a tagged format to a text file.

For this tour, we will use a text file of PubMed references that
were previously downloaded in the tagged MEDLINE format.
The file Pubmed-dinosaur.txt is provided in the EndNote
Examples folder. A single reference in the file appears like this:

PMID - 15759265

OWN - NLM

STAT - Publisher

DA - 20050310

PUBM - Print-Electronic

IS - 1552-4825

DP - 2005 Mar 9

TT - Reconstructing the behaviors of extinct
species: An excursion into comparative
paleoneurology.

AB - How can the behavior of an extinct species

be reconstructed-say a dinosaur such as
Allosaurus? Despite the relatively
abundant fossilized remains of this and
other dinosaurs, the incompleteness of
the fossil record has permitted room for
considerable speculation, mythology, and
perhaps a bit of unsettling reflection on
what factors contributed to the eventual
fate of these remarkably successful
animals. (continued) (c¢) 2005 Wiley-Liss,
Inc.
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Choose the
Correct Import
Filter and
Import into
EndNote

AD -

AU -
LA -
PT -
DEP -

JID -
EDAT -
MHDA -
ATD -
PST -
SO -

Salt Lake City VA-Geriatrics Research,
Education and Clinical Center and
Department of Neurobiology and Anatomy,
University of Utah School of Medicine,
Salt Lake City, Utah.

Rogers SW

ENG

JOURNAL ARTICLE

20050309

Am J Med Genet A

101235741

2005/03/11 09:00

2005/03/11 09:00

10.1002/ajmg.a.30538 [doi]
aheadofprint

Am J Med Genet A 2005 Mar 9;.

Each tag can be mapped to a corresponding EndNote field. If
data is inconsistently tagged, or poorly delimited, it may not be
possible to import all the data accurately.

Once you have captured and saved your data file in a tagged
format, you need to identify the proper EndNote filter to import
the data. There are hundreds of filters included with EndNote;
each one is designed to read a specific tagged format from a
specific information provider.

To import the sample PubMed text file into the Paleo library:

1. Display the Paleo library window in EndNote.

2. From the File menu, choose Import.

Import f@
Imnport D ata File: Choose File...
Import Option: EndMote Library w
Duplicates: Irnport Al b
Text Translation: Mo Translation b

Click the Choose File button to display a file dialog.

Browse to the EndNote X\ Examples folder and then

highlight and Open the Pubmed-dinosaur.txt file.
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From the Import Option list, select Other Filters to display the
list of filters supplied in the EndNote Filters folder.

You may want to peruse the list, to get an idea of what filters
are supplied. You can create new filters, copy existing filters,

and edit filters.

Begin typing “PubMed” to jump to that filter in the list.

=

=

Choose An Import Filter rz|
Name Information Provider L
PsycFIRST (OCLC) OCLC FirstSearch
PsycFIRST (OVID) Ovid
PsycINFO (APA) APA
PsycINFO {C5A) CSA
PsycINFO (DIMDI) DIMDI
PsycINFO (DL) DIALOG
PsycINFO (DS) DataStar
PsycINFO (EBSCO) EBSCO
PsycINFO (OCLC) OCLC FirstSearch
PsycINFO {OVID) Ovid
PsycINFO (SF) SilverPlatter
PSYNDEX (DIMDI) DIMDI W
PSYNDEX (5P) SilverPlatter
PubMed (NLM) National Library of Medicine
Quotations (DL) DIALOG v

Find Cancel ] [ Choose
4 Less Info:
File Name: PubMed {NLM).enf
Created: Tuesday, January 25, 2005, 2:56:14 FM
Modified: Tuesday, January 25, 2005, 2:56:14 PM
Based On:
Category: Mational Library of Medicine
Comments: | Download instructions for NLM PubMed
(http/www_ncbi_nim.nih.gov/PubMed/): v

v

Showing 560 of 560 import filters from C:\Program Files\EndMote X'Filters),

Notice that the Comments section at the bottom of the
window gives tips for downloading references from the

selected source.

With the PubMed (NLM) filter highlighted, click Choose.

Leave the other two options at their default settings:

Duplicates: Import Al

1

By default, a reference is considered a duplicate if the
Author, Year, Title, and Reference Type match a reference
already in the library. You can change the duplicates criteria
under EndNote Preferences. We will import all references
regardless of duplicates.
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Text Translation: No Translation

This option allows you to specify the text character encoding
of the file you import. This is important when you import
references in languages that include extended characters.
You would typically contact your database provider for the
appropriate setting.

9. Click Import to import the file.

When the import is complete, only newly imported
references display in the Library window. This is a perfect
time to add a keyword to all of the imported references using
the Change Field command, or to peruse the imported data to
make sure it imported as expected.

41 Paleo.enl FBEX
B F Author Year | Title Journal/Secondary Title | Ref Type URL
Claridge 2005 History and Development of ... World J Surg Journal Article
Schweitzer 2005 Soft-tissue vessels and cellu... Science Journal Article
Rogers 2005 Reconstructing the behavior...  Am J Med Genet A Journal Article
Ruben 2003 Respiratory and reproductiv...  Physiol Biochem Zool  Journal Article
Kerr 2001 Paleontology. Paring downt .. Science Journal Article
Dalton 2001 Elusive fossil could conceal ... Nature Journal Article
Gurley 1991 Proteins in the fossil bone of .. J Protein Chem Journal Article
Rensberg... 1987 Cracks infossil enamels res... Scanning Microsc Journal Article
< >
l|No References Selected
Showing 8 out of 219 references. & Hide Preview

10. To return all of your references to the library display
(including the newly imported references), choose Show All
from the References menu.
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Summary of
Output
Formats and
Corresponding
Import
Options

A subset of supported information providers are listed here with
their recommended output formats. Check this list for guidance
in order to download in the appropriate tagged format and select
the appropriate import filter. This information was accurate at
the time of publication, but you may need to contact your
information provider if changes occur. You can also check our
Web site at http://www.endnote.com for updated information
and import filters.

Copyright Issues and Fair Use of Downloaded Data

EndNote gives you the capability to import references downloaded from
online databases into its libraries. Some producers of online reference
databases expressly prohibit such use and storage of their data, others
charge an extra fee for a license to use the data in this way. Before you
download references from a database, be sure to carefully check the
copyright and fair use notices for the database. Note that different
databases may have varying restrictions, even from the same information
provider (such as DIALOG or Ovid).

Output Formats and Corresponding Import Options

Information Provider

Recommended Download Format Import Option

AARP AgeLine
(http://research.aarp.org/
ageline/home.html)

There is no method for downloading data | Ageline (AARP) filter
from this database. Instead, save the results
screen as a plain text file with your web
browser’s Save command. The resulting text
file contains tags which are preceded by 18
spaces.
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Output Formats and Corresponding Import Options

Information Provider

Recommended Download Format

Import Option

ACM Digital Library
(Association for
Computing Machinery)

Users with subscription access to this web
site can save multiple records to a BINDER.
Once saved, you can export the records in
an EndNote format.

Non-subscribers can download one record
at a time:

1. Create a search.
2. Click on an article.

3. Scroll half-way down the page and select
DISPLAY EndNote.

Limitations:

Since only plain text files can be imported
into EndNote, you cannot import images,
graphics, etc.

Before importing, you may need to edit the
file to insert a comma after corporate author
names. Otherwise, EndNote will not be able
to distinguish corporate authors from
personal authors.

EndNote Import

CSA
(formerly Cambridge
Scientific Abstracts)

From the CSA search results screen, click
Save/Print/Email. On the “Save/Print/
Email” screen, select:

Record Format: Full Record
Save File Format: PC

Click Save. Your Web browser asks where to
save the file. If your Web browser lets you
save in different file formats, make sure you
save as a “Text Only” (*.txt) file.

Various filters for CSA
databases are provided in
the EndNote Filters folder.

CAS SciFinder

Save references in the “Tagged Format”
(*.txt).

SciFinder (CAS) filter

Current Contents on
Diskette (CCOD) - Mac

Save references in the “EndNote” format.

EndNote Import

Current Contents on
Diskette (CCOD) -
Windows

Save references in the “EndNote” format.

EndNote Import
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Output Formats and Corresponding Import Options

Information Provider

Recommended Download Format

Import Option

DIALOG

Set your communication software's option
to capture text. Use Dialog's Format 5 with
"tag" appended to the TYPE command --
type "s1/5/1-20 tag".

You must download data in Format 5. If
Format 5 is not available, try the “full”
format, which is sometimes the same as
Format 5. For questions concerning Dialog’s
many formats, please contact Dialog's tech
support.

Various DIALOG filters
are provided in the
EndNote Filters folder.

DIMDI

Use the DLOAD command with report D1
(e.g. DLOAD REPORT=D1).

Various DIMDI filters are
provided in the EndNote
Filters folder.

EBSCOhost

After adding your selected references to
your folder, click “View Folder” or “Folder
has items” to see its contents.

If you choose to email or save the references,
uncheck the boxes to include HTML and
PDF; also make sure that “Standard Field
Format” is checked and set to “Detailed
Citation and Abstract.”

If you choose not to save to disk, you must
also check the Bibliographic Manager tab,
then choose “Citations in a format that can
be uploaded to bibliographic management
software” or “Citations in Direct Export
format.”

Various EBSCO filters are
provided in the EndNote
Filters folder.

EDINA

Use the “Name” format, where data is
tagged with words such as “Author” rather
than “AU.”

Because there are so many different formats
used for source data, you may need to
manually edit source data after importing.

EndNote cannot parse author names that
are not clearly delimited, such as

“S Hughes B Reynolds S A Bell & C
Gardner.” You will need to manually edit
author names.

Various EDINA filters are
available in the EndNote
Filters folder.
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Output Formats and Corresponding Import Options

Information Provider

Recommended Download Format

Import Option

Emerald

Display the marked list, click “display for
download (ASCII),” and then save as a plain
text file.

The filter provided works for these Emerald
databases:

Emerald Management Reviews at
http:/ /www.emeraldinsight.com/revs/

Computer Abstracts International Database
at http:/ /www.emeraldinsight.com/caid

International Civil Engineering Abstracts at
http:/ /www.emeraldinsight.com /icea/

Computer & Communications Security
Abstracts at
http:/ /www.emeraldinsight.com/ccsa/

Current Awareness Abstracts at
http:/ /www.emeraldinsight.com/caa/

Limitations:

Page numbers are separated by a hyphen
with spaces on either side of it. You will
need to manually remove the spaces after
importing.

Emerald filter

InfoTrac
(Gale)

From the E-Mail Delivery panel at the
bottom of the marked list window, restrict
the contents to “citation;” do not choose
“full article.”

Limitations:

Records often have extraneous information
in the title field, which must be removed
manually after importing.

InfoTrac (GALE) filter

INIST

1. Click the Enregistrer button.
2. Select the records you wish to download.

3. Under “Quels champs?” choose "Tous les
champs."

4. Under “Incluez” choose "Numéro de
notice et nom de la base de données" and
"Libellés abrégés."

5. Click the Sauvegarde de notices button.

Various INIST filters are
provided in the EndNote
Filters folder.

INNOPAC

Save references in the “EndNote” format.

EndNote Import
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Output Formats and Corresponding Import Options

Information Provider

Recommended Download Format

Import Option

ISI CD (Citation Indexes)

From the File menu, choose Save Records. In
the Save Records dialog, choose the NLM
Medline format from the Export Format
menu.

Citation Indexes (IST)
filter

Knowledge Finder Place document in the Save file, and select | Various Knowledge
the document. Choose Export Selected Finder filters are provided
Documents from the File menu. in the EndNote Filters

folder.

Medscape After selecting the desired records and MEDLINE (Medscape)
adding them to your clipboard, click the filter
Save or Email Clipboard link. Save or email
your clipboard in PC or Mac MEDLARS
format as a plain text (*.txt) file.

NERAC Save your file as plain text (*.txt). NERAC

OCLC FirstSearch Mark those references to be saved and click | Various OCLC filters are
Export. At the next page, choose EndNote | provided in the EndNote
and then click Export. EndNote will prompt | Filters folder.
you to select the corresponding filter.

Ovid After selecting the references you wish to | The appropriate Ovid
download, click Results Manager. Choose the | filter will be selected
following options: automatically when using
Fields: Complete Reference Direct Export option. If
Citation Format: Reprint/Medlars (or youl zfml: ucsllngbOVId s
Direct Export, if available) mu tlple atabase

searching, you must select
Click the Save button. Save the file as plain | 1 pirect Export citation
text (*.txt). format

Ovid for Windows Select the Options button from within the Various Ovid filters are
"Save Documents" dialog box. From the list provided in the EndNote
of options, choose the Output Format, then | FiJters folder.
click OK. On the next screen, choose Reprint
Format.
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Output Formats and Corresponding Import Options

Information Provider

Recommended Download Format

Import Option

ProQuest

1. Select the desired references and then
click the “My Research Summary” tab.

2. Click the “Documents and Bibliography”
tab.

3. Choose “Export,” then either “Export
directly to ProCite, EndNote or Reference
Manager,” or “Download in a format
compatible with ProCite, EndNote,
Reference Manager and RefWorks.” If you
choose the former, make sure your data is
displayed in a tagged format before saving
as a text file.

ProQuest filter

PsycINFO
http://www.apa.org

After marking the records you wish to
download, choose Full PsycINFO Record
then click the Display Marked Records button.
Select the text, then copy and paste it into a
text editor, saving the file as plain text
(*.txt).

Use the PsycINFO (APA)
filter.

PubMed

From the drop-down list next to “Display,”
choose MEDLINE. From the “Send to” list,
choose File. Use your browser to save the
page as a plain text file (*.txt).

You can check current download
instructions for NLM PubMed at any time at
http:/ /www.pubmed.gov.

PubMed (NLM) filter

Reference Update

Select Reference Listings from the Output
menu, and choose the following options:

Device: ASCII File - No Printer codes (be
sure to enter the path and file name for the
output file.)

Output Format: Medline
Click Print to create the output file.

Reference Update (ISI)
filter
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Output Formats and Corresponding Import Options

Information Provider

Recommended Download Format

Import Option

SilverPlatter WebSPIRS

Once you've obtained your search results,
click Save. Select the following “Save
Records” options:

Which fields?: All fields
Include: Record number and database name
Field labels: Short labels.

Click the Save Records button. Use your Web
browser to save the page as "Text Only" (do
not save in HTML format).

Various SilverPlatter
filters are provided in the
EndNote Filters folder.

STN Set your communication software’s options | Various STN filters are
to capture text to a file. Type the command | provided in the EndNote
“Display All”. Filters folder.

UnCover (Ingenta) Using your email software, save references | UnCover INGENTA)
emailed to you as a "Plain Text" or "Text
Only" file.

VHL 1. After selecting the desired references, Various VHL filters are

(Virtual Health Library)

scroll to the bottom of the page and click
“Your collection” (or “Su selleccion”).

2. Cancel the print dialog, and then save the
screen as a plain text file.

provided in the EndNote
Filters folder.

Web of Science

Display your marked references. Then, look
under Output Records and select the option
to output Full Records. Next, click Export to
Reference Software to have the references
exported directly to EndNote. (See “Direct
Export from Web Pages” on page 63.) You
may also choose Save to File to save the
references to a text file and import them into
EndNote.

ISI-CE

Wilson

Select the following options
Destination: Choose e-mail or save.

Include: Record numbers and full-text links
(optional).

Format: Choose text.

WilsonWeb
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Direct Export
from Web
Pages

Certain web sites contain a download button that will send your
search results directly to EndNote, pick the correct import filter,
and start the import process automatically. All you need to do is
choose the EndNote library into which the data should be
imported. This “direct export” or “direct download” method
does away with the additional steps of saving the references to a
text file, and then importing that file with the appropriate filter.

The systems listed below provide a direct export of references
into EndNote. A detailed table of instructions can be found in
Appendix D of the full EndNote manual. The list keeps growing,
so check our web site at http:/ /www.endnote.com for updates!

American Psychological Association, PsycInfo Online
Bausch & Lomb
Bibliotech.dk
BioMedCentral
BioOne

Blackwell Synergy
BM]

Buffalo University
Canadian Journal of Communication
Delphion

EBSCO

EI Engineering
Elsevier

EMBASE

ERIC

Google Scholar

IEEE

JAMA

JSTOR

Karger Publishing

Los Alamos National Laboratory
MicroPatent

Nature

Nerac

NISC

OCLC

OhioLink

OVID

Oxford Press Journals
Pacific Northwest Labs
Patent Cafe

LR 2B 2R 2R 2R 2R 25 2% 2 2R 2% 2% 25 25 2R 2 2R 2R 2B 25 2R 2B 25 2R 2B 2R 2B 2B R 2B 2
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Related
Sections in the
Full Manual

L 2R 2B 2R 2R 2B 2R 2B 25 2% 2R 2% 2% 4

PILOTS

PNAS Online

ProQuest

RLG

Science Magazine
Scopus

St. John of God, Ireland
Stanford University's Highwire Press
Telemed

Thieme

Web of Science
WebFeat

WilsonWeb

This concludes the tutorial for using EndNote’s Import
command.

See these sections in the full EndNote.PDF manual for
information related to this portion of the tour:

¢

See Chapter 7, “Importing Reference Data into EndNote,” for
details about import options and about importing references
from other bibliographic software programs.

Read Chapter 16, “Filters,” to learn how to create or modify
filters that map downloaded references to corresponding
fields in EndNote. You can enter tags and map them to
specific EndNote fields.

See Appendix D, “Direct Export Formats and Import
Formats” for detailed tables of instruction for importing
reference data from various online systems.
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Chapter 7: Searching an EndNote Library and
Printing Directly from EndNote

In this part of the guided tour you will learn how to:
¢ Search an EndNote library for a subset of references.
¢ Print an independent bibliography from EndNote.

In this part of the tour, you will search for a set of related
references and print them, as though to share the information
with a colleague.

Open the Paleo If EndNote is not already running, start it and open the Paleo
y ) P
Library library (Paleo.enl), as shown under “Start EndNote” on page 21.

Search fora Set Let us assume that you want to generate a list of all references

of References found in the Paleo library about extinction that were published
from 1990 to 1999.

To search for references:
1. From the References menu, choose Search References (CTRL+F).

2. If the More button is available, click it to display more search
options.

-
i Search Paleo.enl

[ |Any Field v| |C0ntains v| [and 1~ =
| | Any Field v/ | contains v| [and v
| | Any Field v/ | contains v =
Search  [Paleo.enl v|
toggles between Moreto —f—aless
AT, LR [
| savesearch | [ Loadsearch | [ setDefault | [ Restore Default |
| addreld | [ mnsertField | [ DeleteField | [ insertspecal |

3. Type “extinct” as the first search term.

-
i Search Paleo.enl

Search In

|extinct Any Field V| |C0ntains v| And W
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The words Any Field next to “extinct” mean that EndNote
will find references that have the string “extinct” in any field.
The Contains comparison operator means that EndNote will
search for this string of text anywhere in the field.

Next, set up the search to find references dated from 1990 to
1999.

4. Type 1990 as the search term for the second search line.
From the field list in the second search line, choose Year; and
from the comparison list, choose is greater than or equal to.

5. If you do not have a third search line available, click the Add
Field button found along the bottom of the window.

You may want to click and drag the bottom right corner of
the window to size it larger.

6. Type 1999 asthe search term for the third search line. From
the field list in the third search line, choose Year; and from
the comparison list, choose is less than or equal to.

7. Notice the “And, Or, Not” logical operator list at the end of
each search line. Select the “And” logical operator between
the three search lines.

Your search window should look like this:

-
i Search Paleo.enl

field list = ~" logical
search term \ W\Any Field v | | contains v| |and 224 operator list
) ’1990— ‘fear + | |Is greater than or equal %
’1999— ‘fear | |[slessthanorequalte =T &K qomparison
list
Search Paleo enl N [ Search ] [ Close ]
4 |less
Search Whole Library v | [Omatch Case  []Match Words
[ Save Search ] [ Load Search ] [ Set Default ] [Reshore Default]
[ Add Field ] [ Insert Field ] [ Delete Field ] [ Insert Special ]

This search will find all references containing the text
“extinct” that also were published between 1990 and 1999.

Notice that the following check boxes are not selected for this
search:

Match Case: This option would limit our search to “extinct”
in lowercase. If it were found capitalized at the beginning of
a sentence, or all uppercase, it would not match the search.

Match Words: This option would limit matches to full
words, with no truncation. The word “extinction” would not
match our search.
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8. Click the Search button to begin the search. In a moment,
EndNote displays the search results.

il Paleo.enl E—I@|g|
B F Author Year | Title Journal/Secondary Title | Ref Type URL
Billoski 1992 Introduction to Paleontology 2 Book
Schwartz 1990 Greenhouse hypothesis: effe . Extinction Book Section
Argus 1993 MNew paleontological excavat... Journal of Paleontology  Journal Article
Billoski 1993 Debate Science Journal Article
Morehouse 1993 Statistical evidence for early...  Journal of Paleontology  Journal Article
Jacobson 1999 Impacts of meteorites on Ea... Book
< >
l|No References Selected
Showing & out of 219 references. & Hide Preview

Preview and
Print the
Found
References

The status area at the bottom of the Library window should now
read, “Showing 6 out of 219 references.” You are looking at the

same Paleo library as before, but EndNote has restricted the view
to display only the results of the search.

You can close the Search window now. You also may want to
click the Author column heading to sort the found references by
author name.

Now that you have located all of the desired references, you are
ready to print them.

In order to format your references, you need to select a style.
Styles determine how your references look when you print,
export, preview, or create bibliographies.

While you can print directly to a printer, you may want to save
to an RTF file instead. An RTF file can be opened by any word
processor, where you can fine tune headers, footers, page
numbers, font styles, etc., before printing.

To preview the bibliography:

1. On the Main toolbar, select an output style from the output
style list. For this example, choose the Numbered style.
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2.

From the File menu, choose Print Preview to display the
bibliography on your computer screen.

Paleo.enl Page 1

1.

Argus, MY New paleanfoiogical excavation fechniques. Joumal of
Paleontolagy, 19593, 19: p. 234-237.

Billoski, T.%, fnfroduetion to Paleorfoiogy 2. Bth ed. 1992, New Yark:
Institutional Press. 212,

Billoski, T%., Dehate . Science, 1993. 77. p. 5-6.

Jacobson, C.and J. Roe, Impacts of mefecrites on Earth. 1999, Mew york:
Blackcourt Press. 100.

Morehouse, 5.1, and RB.5. Tung, Stafistical evidence for early extingtion of
repfifes due fadhe KT evend Journal of Paleontology, 1993 17(2) p. 1953209
Schwartz, M.T.and T, Billoski, Greenhouse fypoihesis: effect on dinosalr
extinction, in Extinefion, B.T. Jones and M . Lavecraft, Editors. 1990, Barnes
and Ellis: Mew Yark. p. 175-189.

3.

4.

You can use the buttons along the top of the window to walk
through the pages of the bibliography.

When you are done previewing, click the Close button.

To save the bibliography to a word processor file:

1.

AN

On the Main toolbar select an output style. For this example,
choose the Author-Date style.

From the File menu, choose Export. A standard “Save As”
dialog appears.

Select a folder location, and type in a name for your file.
Next to the Save As Type label, select Rich Text Format (*.rtf).
Click Save to save your formatted bibliography to the file.

You can use any word processor to open the RTF file, such as
Microsoft Word or WordPerfect. You can make any changes
you like, and then print from the word processor.

To print the bibliography to a printer:

1.

3.

On the Main toolbar select an output style. For this example,
choose the Numbered style again.

From the File menu, choose Print. A standard print dialog
appears.

Click Print or OK to begin printing.

Once you are done printing your search results, you may want to
return to the full list of references in the Paleo library. To show
all references again in the library window, go to the References
menu and select Show All References.
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This concludes this part of the guided tour. Chapter 8
demonstrates how to write a paper and cite references and
figures in Microsoft Word.

If you are finished working with EndNote for now, go to the File
menu and choose Exit to close the EndNote program.

Related See these sections in the full EndNote.PDF manual for
Sections in the information related to this portion of the tour:

Full Manual ¢ More information about searching the EndNote library can
be found in Chapter 8.

¢ Read Chapter 12 about creating reference lists directly from
your EndNote library.

¢ See Chapter 15 for information about modifying and
selecting styles.
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Chapter 8:

Using EndNote While Writing a
Paper with Microsoft Word

NOTE: Continue with this part of the tour only if you use Microsoft Word
2000, XP, or 2003. If you use a different word processor, or if you have
an older version of Word, turn to Chapter 11 in the full EndNote.PDF
manual to learn how to cite EndNote references and create
bibliographies in your papers.

Open the Paleo
Library

Open a
Microsoft
Word

Document

EndNote’s Cite While You Write feature inserts EndNote
commands into Word’s Tools menu to give you direct access to
your references while writing in Microsoft Word. The Cite While
You Write commands enable EndNote to do bibliographic
formatting to the document that is currently open in Word.

In this part of the guided tour, you will learn how to:

¢ Insert EndNote bibliographic citations into your paper and
create a bibliography.

¢ Edit citations to suppress author names and add cited pages.

¢ Insert EndNote figure citations into your paper. (This section
uses the image references that were inserted while following
Chapter 4 of the guided tour.)

If EndNote is not already running, start it and open the Paleo
Library (Paleo.enl), as shown under “Start EndNote” on page 21.

EndNote will look for matching references in the currently open
libraries. While EndNote can automatically start and open your
default library when needed by Word, opening the library first
assures you that you are citing references from the appropriate
library.

For this tour, start Microsoft Word and open a new document.

While we are not using one for this tour, EndNote does include
manuscript templates that make it easy to set up your paper for
electronic submission to a publisher. When you use one of these
templates to start your paper, many formatting issues are
already set up for your target publication, such as proper
margins, headings, pagination, line spacing, title page, font type
and size, etc. For more information about using manuscript
templates, see “Using Predefined Manuscript Templates” in
Chapter 10 of the full EndNote.PDF manual.
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Cite EndNote
References

You are going to start entering text and citations. For this tour,
you are going to enter minimal information.

To start writing your paper and inserting citations:
1. Enter text as though you were writing your paper:

The fossil in guestion was generally
regarded to be the 220 million year-old
remains of tyrannosaurus. Several years ago,
however, Morehouse overturned this hypothesis
with the discovery of yet another species.

Now you are ready to insert a citation.

2. From the Tools menu, go to the EndNote X submenu and then
Find Citation(s).

[ 100k |

[ Enduotex v |[& Find citation(s)...

% speling and Grammar... F7 Go To EndMote

@ Track Changes  Ctrl+Shift+E %E Format Bibliography...
Templates and Add-Ins... % Insert Selected Citation(s)
Customize. .. i Edit Citation(s)...
Qptions... é Insert Mote...

J §£ Edit Library Reference(s)
E‘)J Unformat Citation(s)

¥y Remove Field Codes

Export Traveling Library. ..

fig. Find Figure(s)...

o Generate Figure List

% Cite While You Write Preferences. ..

% Hep

3. The EndNote Find Citations dialog appears. Type the author
name “Morehouse” in the “Find” box and click Search.

72 Chapter 8: Using EndNote While Writing a Paper with Microsoft Word



EndNote lists the matching references. In this case, a single
reference matches the search.

=

EndNote Find Citation(s)

Find: | Morehouse j Search

Example: Enter Billoski dinosaur extinction to search for these terms in all fields

Authar Year Title

Morehouse

< | >
Reference Type: Journal Article ~
Record Number: 125 E
Author: Morehouse, 5.1 3
Tung, R.5.
Year: 1993
Title: Statistical evidence for early extinction of reptiles due to the KT
event b
Insert | Cancel | Help |
Library: Paleo.enl 1 items in list

4. Click Insert to insert the selected reference as a citation.

EndNote not only inserts a citation, but Instant Formatting
formats the citation in the currently selected Numbered style
and adds it to a formatted bibliography at the end of the

paper.
5. Add more text to the paper:

It is now the undisputed progeny of the
species at hand.

6. From the Tools menu, go to the EndNote X submenu and then
Find Citation(s).
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7. Type the number “1987” into the find box and click Search.
EndNote searches all fields and lists the matching references.

=

EndMote Find Citation(s)

Find: | 1387 | Search

Example: Enter Billoski dinosaur extinction to search for these terms in all fields

0 ion
Pl ary ments ak Caravar
Kreutzer 1937 Untersuchungen Gber die Regulation der Bildung glykolytisch

McCorrmick, 1939 Ankarctic measurements of ozone by Sage-IIin the spring of

Pollastro 1937 Mineralogy and petrology of the Cretac Tertiary bound: 3

Fluime 1o Crlidn irmmmmbr  mmid v mim —ed ks ek =k bl Tk

£ >

Reference Type: Journal Article ~

Record Number: 46

Author: Billoski, T.%.

Year: 1957

Title: Triceratops extinction linked to asteroid collision

Journal: Science

Yolume: 79 b
Insert | Cancel | Help |

Library: Paleo.enl 10 items in list

8. Scroll down the list of matching references, select the
reference by the author Turnhouse, and click Insert.

EndNote inserts the citation, and Cite While You Write
technology formats it and adds it to the bibliography at the
end of the paper. Your document text should now look like
this:

The fossil in question was generally regarded to be the 220 mullion
year-old remains of tyrannosaurus. Several years ago, however, Morehouse
overturned this hypothesis with the discovery of yvet another species. [1] Tt is

now the undisputed progeny of the species at hand. [2]

1. Morehouse, S.I and R.S. Tung, Siatistical evidence for early extinction
of repiiles due io the K/T event. Journal of Paleontology, 1993. 17(2): p.
198-209.

2

Turnhouse, M.B., Role of 14C dating in paleontology. Journal of

Paleontology, 1987. 75(6): p. 11-15.

NOTE: You can shade each of the Cite While You Write citation and
bibliography fields so they are easy to locate. This is set with Microsoft
Word’s Field Shading option. The shading is for on-screen help only,
and does not print.
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9. Assume that you have finished inserting citations in your
paper. From Word’s File menu, choose Save to save your
document.

NOTE: You can also insert citations in footnotes. First, use the
appropriate Word command to create the footnote. Then, insert the
EndNote citation in the footnote. Word controls the placement and
numbering of the footnote, and EndNote formats the citation based on
the current style. You must select a style that formats footnotes; for
example, Chicago 15th A.

Select a

You can format your citations and bibliography as many times as

B1b110gr aphic you like, changing the output style and various other layout

Style

settings each time.

To select the bibliographic style used for formatting:

1. From Word’s Tools menu, go to the EndNote X submenu and
choose Format Bibliography.

Tools |

[ Enduotex 3

€} Find Citation(s)...
% speling and Grammar... F7 Go To EndMote
|5» TrackChanges Ctrl+5hift+E

%2 Format Bibliography...
+.

Templates and Add-Ins... "1 Insert Selected Citation(s)
Customize. .. i Edit Citation(s)...
Qptions... é Insert Mote...
¥ §£ Edit Library Reference(s)
E‘)J Unformat Citation(s)

¥y Remove Field Codes

Export Traveling Library. ..

fig. Find Figure(s)...

o Generate Figure List

% Cite While You Write Preferences. ..

% Hep
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A Format Bibliography dialog appears, where you can select
a bibliographic style.

B |

EndNote Format Bibliography f@

Faormat Eibliography lLayout ] Instant Formatting ] Libraries Used ]

Format document: |Test.d0c j
‘With output style: |Numbered j Browse, .. |
Annotated
Temporary citation|APA Sth
Author-Date
Left: |4

Show &ll

OF | Cancel | Help |

Styles contain instructions for how EndNote will format
citations and the bibliography. For the previous example, we
illustrated the Numbered style, which sequentially numbers
citations and then inserts a numbered reference list at the
end of the paper.

As you can see, there are many other formatting options
available here; you can make changes that override the
settings in the current output style.

2. For this example, click the Browse button next to “With
output style” to display the list of output styles supplied
with EndNote.

Select the APA 5th style and click OK.
4. Click OK to leave the Format Bibliography dialog.

EndNote automatically updates the existing citations and
regenerates the bibliography in the APA style.

In the future, if you need to make changes to the paper such as
adding or deleting citations or text, just do the necessary updates
in your paper. If you want to change the output style or
bibliography layout settings, choose the Format Bibliography
command again. EndNote will reformat the in-text citations and
generate a new bibliography based on your changes.

NOTE: More than 2,000 styles are installed in EndNote’s Styles folder.
To see a list of them organized by discipline, choose Output Styles from
the Edit menu in EndNote and select Open Style Manager.
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Edit a Citation

If you directly edit a citation or the bibliography, the changes
will be lost when you Format Bibliography again because EndNote
reformats according to the rules of the selected output style. To
make and retain changes to all citations and / or the bibliography,
modify the output style. However, if you want to make a change
to an individual citation, use the Edit Citation command as
described below.

For some bibliographic styles, the majority of references are cited
in an “Author, Date” format; but if the author’s name is
mentioned within the paragraph text, the style dictates that the
name not be repeated in the citation. In our example, we mention
Morehouse within the text of the paper, so we will remove the
author’s name from the citation. We also want to add a page
reference to this particular citation.

To edit an individual citation:
1. Click anywhere on the Morehouse citation.

2. From the Tools menu, go to the EndNote X submenu and then
Edit Citation. (Or, right click with your mouse and select Edit
Citation from the context-sensitive menu.)

- .

EndNote Edit Citation 53

Use this window to view, select, edit and remove citations from your current document,

Cikations in document: Faormatted Citation

of yet another species, (...} It is now the

™ Exclude authar ™ Exclude year

| Morehouse, 5
the species at hand. (...} Prefix: |
Turnhouse, 1987 #176
Suffix: |
Pages:|
Insett... Remove | 5l =
Reference Type: Journal Article ~
Record Number: 125
Author: Morehouse, 5.1,
Tung, R.5.

Year: 1993
Title: Statistical evidence For early extinction of reptiles due to the KT event
Journal: Journal of Paleontology v

o]

2 citations

Cancel | Help |

lLibrary: Traveling Library

3. In the Formatted Citation section, select the Exclude Author

box.
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4. Next to Pages, type “34-35".

NOTE: Typing cited page numbers in this box does not guarantee that
they will appear in your citation. You must use an output style that lists
the “Cited Pages” field in the Citation template. You can edit any style
to include this special field.

5. Click OK to update the citation in your paper.

The fossil in question was generally regarded to be the 220 million
year-old remains of tyrannosaurus. Several years ago, however, Morehouse
overturned this hypothesis with the discovery of yet another species. (1993,
pp. 34-35) It is now the undisputed progeny of the species at hand.
(Turnhouse, 1987)

Morehouse, S. L, & Tung, R. S. (1993). Statistical evidence for early
extinction of reptiles due to the K/T event. Journal of Paleontology,
17(2), 198-209.

Turnhouse, M. B. (1987). Role of 14C dating i paleontology. Journal of
Paleoniology, 75(6), 11-15.

Insert Figure Next you are going to insert two figure citations—one inserted

Citations and numbered as a figure, and one inserted and numbered as a
table. This section uses the references inserted in Chapter 4:
“Entering References.”

All figure citations are inserted in the same way; the EndNote
reference type determines whether it is inserted and numbered
as a figure or a table. Images found in the Chart or Table reference
type are inserted as tables, while images found in any other
reference type are inserted as figures.

To find and insert figure citations:
1. First, add more text to your paper:

As researchers look at evidence, even the
crest on the modern cockatiel provides insight
into the evolution of feathers.

Now you are ready to insert a figure citation.

2. From the Tools menu, go to the EndNote X submenu and then
Find Figure(s). The EndNote Find Figures dialog appears.
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3. Type the search term “bird” in the “Find” box and click
Search.

=

EndNote Find Figure(s)

Find: | bird j Search

Authaor | vear | Title | Caption
Mational Geographic 5... Bird evolution Bird Evolution
Rex 1995 The scale and the feather--a sugg...  Cockatiel Crest Feathering

<

| ™

EVOLUTION OF A WING

Insert | Cancel ‘ Help ‘

ll;ibrar\;': Paleo.enl 12 items in list

EndNote lists only references that match the search text and
contain an image. As you highlight a reference, the graphic
stored within the reference is displayed below the reference
list.

You can use your mouse to move the column dividers to set
column widths and to drag the lower right corner of the
window to adjust the size of the window.

4. Select the reference with the Caption “Cockatiel Crest
Feathering,” a reference inserted earlier in this guided tour,
and click Insert to insert the figure citation.

Asresgearchers look at evidence, even the crest on the modern
cockatiel provides insight into the evolution of feathers. (Figure 1)

5. Next enter the text:

While exploring the evolution of dinosaurs
and birds, it becomes clear that Homo sapiens
have occupied earth for a relatively short
period of time.

Now you are ready to insert a reference to the Microsoft
Excel file we inserted into an EndNote reference earlier in
this guided tour.
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6.

7.

From the Tools menu, go to the EndNote X submenu and then
Find Figure(s). The EndNote Find Figures dialog appears.

Type the text “hominid” in the “Find” box and click Search.

EndNote displays a single matching reference. The file
attachment icon shows that the figure is in a Microsoft Excel
document.

@ B

EndNote Find Figure(s) 3

Find: | harminid

j Search

Capkion
Harminid Timeline

lLibrary: Paleo.enl

Insert |

Cancel |

Help

1 items in list

Click Insert to insert the citation. (It may take some time for
Word to import the file.)

The image was found in the Chart or Table reference type, so

it was added to Word and numbered as a table.

Asresgearchers look at evidence, even the crest on the modern
cockatiel provides insight into the evolution of feathers. (Figure 1)

While exploring the evolution of dinosaurs and birds, it
becomes clear that Homo sapiens have occupied earth for a
relatively short period of time. (Table 1)

9. Scroll to the end of the document, and you will find that

EndNote used Word bookmarks to place the images under
labeled List of Tables and List of Figures sections as defined
by the APA style.

10. You may need to resize the Hominid Timeline to fit on the

page. Click on the image, and then hold down the Shift key
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while you drag a corner of the figure to resize it
proportionally.

List of Tables
Tahle 1.
Hominid Timeline

Hominil Timeline

- =]

Tirne [in milliors of wears)
ta

4

Buetralopithecits ramidus
Buetral opithec s afarersis
Bustrd opithecus Fricanus
Buetral opithecits robusts
Homne Fabilis
Homo erectus
Horno sspiens
Horno sapiens
neardertd ersis
Horno sapiens sapiens

11. You can also reduce the size of the Cockatiel Crest
Feathering graphic.

List of Figures

Figure 1. Cockatiel Crest Feathering

As you are working, remember to often Save your document.
You can continue adding text, bibliographic citations, and figure
citations to the paper, and EndNote will continue adding to the
lists of references, figures, and tables!
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This completes the guided tour. Exit Microsoft Word by
choosing Exit from the File menu.

To close the EndNote program, go to the File menu in EndNote
and choose Exit.

Related See these sections in the full EndNote.PDF manual for

Sections in the information related to this portion of the tour:

Full Manual ¢ The process of citing references and figures and creating
bibliographies with Cite While You Write is covered in
Chapter 10.

¢ More than 2,000 styles are installed in EndNote’s Styles
folder. To see a list of them organized by discipline, choose
Output Styles from the Edit menu and select the Style
Manager. See “ Accessing Styles in Other Places” in Chapter
15 for information about how to access other styles.

¢ Chapter 15, “Bibliographic Styles,” includes instructions for
editing output styles.
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